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1 GOALS

After completing this section, you will have gained the skills to:
- Create a new Plugin
- Define a new Extension
- Implement a new Tool Extension

- Update the user interface from within a tool.

2 CREATE ANEW PLUGIN

In this section you will create a new plug-in for the feature editor.
1. Open the Plug-in Development perspective.

2. From the File menu, select New — Project.... Select Plug-in Project from the
dialog, and then click the Next button.

& New Project E|

Select a wizard

—

Create a Plug-in Project

\Wizards:

122 Java Praject

£ Java Project from Existing Ant Buildfile
'—{Dﬁ Flug-in Project

[ Y5

+-[z= Eclipse Modeling Framework,
4= Java

+-[z= Plug-in Development

+-[z= Simple

| Mext > | | Cancel |

Figure 1 - New Plug-in Project

3. Create a name for the plug-in by entering
net.refractions.udig.tutorials.distancetool in the Project Name text field and
click the Next button.
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& New Plug-in Project

Plug-in Project %{3 .
Create a new plug-in project Fa

Project name: | net.refractions.udig. tutorials. distancetool |

~Project contents
v Use default

~ Project Settings
[v Create a Java project

Source Folder Name: | src

Qutput Folder Name: | bin

—Plug-in Format -
What version of Eclipse is this plug-in targeted for? |3.1 v}
V¥ Create an 05Gi bundle manifest

< Back | Mext = | | Cancel

Figure 2 - Naming the New Plug-in

4. Accept the default values used to generate the plug-in and click the Finish
button.

& New Plug-in Project

Plug-in Content gg o
Enter the data required to generate the plug-in. 7

1~ Plug-in Properties -

Plug-in ID: | net, refractions, udig. tutorials. distancetool

Plug-in Version: | 1.0.0

Plug-n Name: | Distancetool Plug-n

Plug-n Provider: |

Classpath: |

i Plug-n Class -
¥ Generate the Java dass that controls the plug-in's life cyde

Class Name: ] net.refractions, udig, tutorials, distancetool . DistancetoolPlugin
¥ This plug-n will make contributions to the UI

1~ Rich Client Application
Would you like to create a rich dient application? = Yes i No

< Back ‘ Mext > | Einish | Cancel

Figure 3 - New Plug-in Details

At this point the feature editor plug-in is created. Configuring the plug-in is the
focus of the next section.
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3 CONFIGURING THE NEW PLUG-IN

In this section you will configure the feature editor plug-in. Specifically, you will
specify dependencies on other plug-ins in order to create a new feature editor.

1. Open the Plug-in Development perspective.

2. In the Package Explorer navigate to the plug-in created in the previous
section. Open the plug-in manifest by navigating to the META-INF —
MANIFEST.MF file under the root of the feature editor plug-in. Double click
on the file to open the plug-in manifest editor.

£ Plug-in Development - net.refractions.udig. distanceTool - Eclipse SDK
File Edit Source Refactor Mavigate Search Project Run Window Help

| 9 = oo *3 0-Q- | BHG- | ®F |- 5

= E' Jﬂ}net refractions.udig.distanceTool E@

: : @ || 5g Overview
I:T main ~

& ','7 net.refractions.udig.catalog

[+ ‘.. net.refractions.udig. catalog.arcsde
[T""i? net.refractions.udig.catalog. codi i : i
& L‘:«' net refractions.udig.catslog. geotiff ID: net.refractions,udig. distance tool
&l ‘7 net.refractions.udig.catalog. gml Version: 1.0.0

¥ p net.refractions.udig.catzlog. memory Mame: DistanceTool Plug-in

128 metirefractions. udig. catalog.orade Provider: Refractions Research Inc

=l ‘[7d net.refractions.udio.catalog. postgis e _
l;ﬁ b net refractions.udig. catalog. rastering = Class: [net.reﬁactons.ud|g.d|siance tool.DistanceToolP
] '7 net.refractions.udig.catalog.shp Platform filter: |
[+l b net.refractions.udig.catalog. tests

F! fg__—,- net.refractions.udig.catalog. tests.ui

[+ 1,.;- net.refractions.udig.catalog. tests. wi Testing

2] ‘d,?‘ net.refractions.udig. catalog.u
- :,- net.refractions.udig.catalog.w

General Information
This section describes general information about this plug-in:

Test this plug-in by launching a separate Edipse application:

H ‘[ 4 net refractions.udig.catalog. wms > Lﬂuucb.ﬁuﬁ&hﬂﬁ.ﬁnﬂlﬁﬂm

# ,_p‘ net.refractions.udiq. catslog. worldimz ffr Launch an Edlipse application in Debua mode

- ‘};‘f- net.refractions.udig.core

=12 net.refractions.udig.distanceTool £
+'l5 SrC Ovemew Dependencles Runhme Extensmns B(tﬂmn Punl3 I
(7= icons — = —
(=] (2 META-INF rasks {2 Prahlems EE Properhes Cunscﬂe Cal H&Mv .R.
L -{'{)} MANIFEST.MF 0 errors, 0 warnings, 0 infos (Filter matched 0of 1 GGG items)
|n:j build. properties 5

| ik plugin, xmi . S

|;+J’_7‘J net.refractions.udig. feature_editor Description | Resource | InFok

[#-[==% net.refractions.udig.help
] [ net,refractions.udig.libs

-5 net.refractions.udia.maparaphic o4
il ke &
[ | MANIFEST.MF - net.refractions, udig.distanceTool fMETA-INF

Figure 4 - Plug-in Manifest Editor
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3. Open the plug-in dependencies by clicking on the Dependencies tab located

at the bottom of the editor area.

& Plug-in Development - net.refractions.udig.distanceTool - Eclipse SDK

File Edit MNavigate Search Project Run  Window Help
9~ m | #-0-Q- | BHG- | ®F |-
I ts-Package Explorer E@ _.”.2 = E efractions.udig. di

B B~ Dependencies

121 main ~

Reguired Plug-ins
Specify the list of plug-ins required for the
operation of this plug-n:
Jeiorg edipse.ui |
q-%I::org.En:lipse.core.runh’me

%}net.reﬁacﬁons.udig.libs

%anet.refracﬁons.udig.project.

+ :;,- net.refractions.udig.catalog

= :/7‘1 net.refractions.udig.catalog.arcsde
[t :;‘,J- net.refractions.udig.catalog. codi
+fg‘J net.refractions.udig. catalog. geotiff
+ fi== net.refractions.udig.catalog.gml
e ::‘fv net.refractions.udig.catalog. memory
+ :7‘1 net.refractions.udig.catalog.orade
= ::‘fv net.refractions.udig. catalog. postagis
B IU‘J net.refractions.udig.catalog.rastering
] = net.refractions.udig.catalog.shp
5
e
5
5
£
e
£
5

IU‘J net.refractions.udig.catalog. tests
IU‘J net.refractions,udig.catalog, tests.ui
| Ijjv net.refractions.udig.catalog. tests.wf
H :;‘,J- net.refractions.udig.catalog.ui

el ::‘fv net.refractions.udig.catalog. wis <
:7‘1 net.refractions.udig.catalog.wms

1+ ::‘fv net.refractions.udig. catalog. worldime
B :7‘1 net.refractions.udig.core

» Dependency Analysis

FEX

Imported Packages

Specify packages on which this plug-in dej
without explicitly identifying their originati
plug-in:

A

=122 net.refractions.udig.distanceTocl A : : : - R
-2 src Overview | Dependencdies | Runtime | Extensions | Extension Points | Build | MANIFEST.MF | ¥
[+ icons — : T T — T TR —
- META-INF Tasks | [2( Problems &2 Properties | Console | Call Hierarchy | JUnit | Progress | ~ 2 8
- -L‘?} MAMIFEST.MF |0 errors, 0 warnings, 0 infos (Filter matched 0 of 1,669 items) =
E‘, build.properties
— -+l
: {f]_} plugin.xml 5 = ) ]
f,:‘f' net.refractions.udig. feature. editor Description 1 Resource 1 In Folder I Loca |
+#-1=F net.refractions.udig.help
= I;_—‘,Jv net.refractions.udig.libs
#5224 net.refractions.udia, maparaphic (&
! > & ! b

Figure 5 - Plug-in Dependencies

plugins:
a. net.refractions.udig.libs

b. net.refractions.udig.project.ui

to propagate into the project.
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Click the Add... button in the Required plugins column and add the following

At this point it is critical that you save your work as the dependencies need



& Plug-in Selection : |E”z|

Select a Plug-in:

]

“f=net.refractions.udig. feature. editor (0.2.0)
“l=net.refractions.udig. help (0.8.0)
net.refractions.udig.libs (0.9.0)
#J=net.refractions.udig.mapgraphic {0.9.0)
4=net.refractions.udig.printing. model {0.8.0)
== net refractions.udig. printing. model, edit {0.8.0)
“J=net.refractions.udig.printing.ui (0.8.0)
“=net.refractions.udig.project (0.8.0)
“J=net.refractions.udig. project.edit (0.8.0)
“l=net.refractions.udig. project. tests (1.0.0)
“J=net.refractions.udig.project. tests.ui {1.0.0)
¢net. refractions. udig. project.ui (0.9.0)

i - g R PR S,

| *

%

Ay &
W

Figure 6 - Add New Plugin Dependencies
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4 |MPORT RESOURCES INTO PROJECT

1. Select the new project, net.refractions.udig.tutorials.distancetool, in the
Package Explorer.

Select File — New — Folder from the Menubar.
Enter icons as the folder name.

Click the Finish button.

Select icons directory.

Select File — New — Folder from the Menubar.
Enter pointers as the folder name.

Click the Finish button.

© N oo kR Db

Select icons directory.

10.Select File —» New — Folder from the Menubar.
11.Enter etool16 as the folder name.

12.Click the Finish button.

13.Right click on etool16 and select Import.
14.Select File System.

Select \
Impart resources from the local file system into IE - 5 i
an existing project.

Select an import source:

[T Archive file

;.fcheckout Projects from CVS
ﬁExist’ng Projects into Workspace
Lk External Features

5, External Plug-ins and Fragments
e sten

Elpreferences

%LTeam Project Set

| Mext = | | Cancel |

Figure 7 - Import Selection Page
15.Enter tutorials\day1\DistanceTool\images in the From directory field.

16.Select the measure_mode.gif file and press Finish
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& Import @
File system

—
Impaort resources from the local file system.

-

From directory: |L:'n.b_lhorials'n,da\,rIHDistanceTool'n,images j Browse...
[E = images

E'jmeasure_mode.gif
O ®]measure_source.gif

Filter Types... | Select All Deselect Al

Into folder: | net.refractions. udig. distanceTool ficons fetool 16

Browse...
Options
[ Overwrite existing resources without warning

" Create complete folder structure
+ Create sglected folders only

= Back | | Einish | Cancel |

Figure 8 - Import Tool Icon

17.Import the measure_source.gif file into the pointers directory following steps
14 through 16.
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5 DEFINE ANEW EXTENSION

18.0pen the extensions page by clicking on the Extensions tab

19.Click the Add... button

20.Select the net.refractions.udig.project.ui.tool extension point from the list.
21.Click the Finish button.

& New Extension

Extension Point Selection
f y
Create a new extension from the net.refractions. udig. project.ui. tool ‘:J ]
extension point.
Extension Points | Extension Wizards

Available extension points:

=l net.refractions.udig. project. ui. editorInputs ™
=l net.refractions.udig. project. ui. featureEditor

= net.refractions.udig. project. ui.itemProvider AdapterFactories =
b [net.refractions.udig, project.ui. tool
=] org.eclipse.core.runtime. adapters
=l org.edipse.core.runtime. applications

=] org.edlipse.core runtime, contentTypes

=] org.eclipse.core runtime, preferences b

Available templates for net.refractions. udig.project.ui. tool:

¥ show only extension points from the required plug-ins

R =

Figure 9 - Add Tool Extension

22.Enter net.refractions.udig.tutorial.distancetool in ID field of the extension
form.

23.Enter Distance Tool Example in name field of the extension form.

Renfrzasczti;xox"csu Distance Tool Tutorial -11-



& Plug-in Development - net.refractions. udig.distanceTool - Eclipse SDK
File Edit Mawvigate Search Project Run Window Help

o5
u

T anp F-0-G-  EFG- | B B4 % B

s

Extensions

All Extensions Extension Details
Set the properties of the selected extension,
ID:  |met.refractions.udiq. tutorial, distancetoal |

K=l Distance Tool Example] |

Point: |met.refractions.udig.project, ui, tool |

<= net.refractions.udig.project.ui. tool

HEEE

43 Find dedaring extension paint
'%' Open extension point description

b Body Text

Overview | Dependendies | Runtime | Extensions | Extension Points | Build | MANIFEST.MF | plugin.xml | buid.properties

Figure 10 - Enter Tool Extension Data
24 .Right click on newly added extension and select New — modalTool

25.Replace the default data in the id field with
net.refractions.udig.tutorial.distancetool.

26.Enter a tool tip message into the tooltip field (eg "Measure the surface
distance between two points").

27.Enter net.refractions.udig.tutorial.distancetool.DistanceTool into the class
field.

28. Enter icons/etool16/measure_mode.gif into the icon field.
a. Or press the Browse button and locate the icon.

29. Enter Distance into the name field.

30. Set onToolbar to true.

31. Enter net.refractions.udig.tool.category.info into the categoryld field.
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£ Plug-in Development - net.refractions.udig.distanceTool - Eclipse SOK
Bie Edt Mapvigate Search Progect Bun Window Help

L e a -0-Q- | GHG- | B4 Hie %G
O
. retoefractons. .. X lﬂ MenuToolCategory.. .. li Madalitem, java ._D ToolProxy.java T = 8
Extensions B EE E
All Extension Element Details
= f Fr Tool”
= = et refractions,udig.project.ul, tool s m-:pmﬂ;-ertes-::_.'_q?fa“:.l:i_ E——
¥ oo Distance (modaTood) " [ et actions. udg, tutoraldistance too |
taltiz: [ Meagure the surface ditance bebween b

[=fr !ner.r!fra-c‘:m:.udg.furma
icon:= ;isu'u.‘:'.n-c- 15 {measure_moc

A8 EE

name; é.Dlsto'!cal. —l
onTookbar: i-lﬂ-ﬂ B j
categoryld Er-er.reﬁa-::p:ﬂs.ud;-.b:-:nl.-:ahe-:urv.lnf-:n |
commandlds: | |

commandHandker: | .

< |

¢ Bodw

Cverview | Dependendes | Auntime | Extersians | Extension Ponts | Buld | MANIFEST MF | plugin.mi | buld, properties

Figure 11 - Completed Modal Tool Definition

32.Right click on net.refractions.udig.tutorial.distancetool (modalTool) and
select New — cursor.

33.Enter icons/pointers/measure_source.gif in the image field.
a. Or press the browse button and find the pointer icon.

34.Enter 10 in the hotSpotX field.

35.Enter 10 in the hotSpotY field.
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£ Plug-in Development - net.refractions.udig.distanceTool - Eclipse SOK
Bie Edt Mapvigate Search Progect Bun Window Help

B i #-D-Q- | EHG- | @5 B4 % 0
GO -
. petefracnons, udg.dstanceTool X [Z] Copy of plugin.ml =8
Extensions = =
All Extension Element Details
= o= ek, refractions,udig.project, ui, ool |.g,dd... kg e o o Crian
=== net.refractions.udig. tutorial. dstance tog e .E@E.-f?ﬁ.ﬁt_ﬂ:f&vﬂﬂﬂE,%P:J_tﬁ;g.i.f.-
= [ ——— |
I: hat Hp |

= |

< |

¢ Bodw

Cverview | Dependendes | Auntime | Extersians | Extension Ponts | Buld | MANIFEST MF | plugin.mi | buld, properties

Figure 12 - Tool Cursor Definition

The file tutorials\day\DistanceTool\sources\plugin.zip contains the plugin you are
creating at this stage of development. You can compare the work you have done
with the plugin provided if you are having problems.
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6 IMPLEMENTING A MODALTOOL

DY ® N o g

It is a child of the net.refractions.udig.project.ui.tool.
Click the class hotlink.

Check Generate comments.

& Java Attribute Editor

Java Class

Create a new Java dass.

Package: | net.refractions.udig. tutorial. distanceToal Browse...

@’
Source folder: | net.refractions.udig.distanceTool fsrc Browse...

[ Endosing type: |

Name: | DistanceTool

Modifiers: {* public " default s
[ abstract [ final I

9

et.refractions.udig.project. ui. tool. AbstractModalTool

Superclass:

Interfaces:

(1] net.refractions.udig. project.ui. tool. ModalTool Add...

Which method stubs would you like to create?
[ public static void main{String[] args)
™ Constructors from superclass
IV Inherited abstract methods
Do you want to add comments as configured in the properties of the current project?
¥ Geperate comments

Finish | Cancel

Figure 13 - New Class Wizard

Expand AbstractTool node.

Check mousePressed(MapMouseEvent).
Check mouseReleased(MapMouseEvent).
0.Click the OK button.

Distance Tool Tutorial

Select net.refractions.udig.tutorial.distancetool (modalTool) in the Extensions

Enter net.refractions.udig.project.ui.tool.AbstractModalTool in the superclass
field or press the browse button and locate the class.

Press Finish, if not available ensure that all the information is correct.

Right click on editor and select Source — Override/Implement Methods.
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& Override/Implement Methods

Select methods to override or implement: -t Select all

O e getContext || Deselect Al
O e mouseDoubleClicked (MapMouseEvent)

@ mouseDragged{MapMouseEvent)
mouseEntered{MapMouseEvent)
@ mouseExited(MapMouseEvent)
@ mouseMoved{MapMouseEvent)
@ mousePressed{MapMouseEvent)
@

@

oo
®

mouseReleased(MapMouseEvent)
mouseiheeMoved(MapMouse\WheelEvent)

+-[]® Object

OEEO0O

Insertion point:

|Cursor position ﬂ

™ Generate method comments

The format of the method stubs may be configured on the Code Templates preference page.

i 20of 17 selected.

Ok | Cancel |

Figure 14 - Override Methods Dialog

11.Add a constructor that will register the tool for mouse events:

public DistanceTool () {
// Register for mouse events
// Options are:
// MOUSE
// MOTION
// WHEEL
super (MOUSE) ;

12.Implement the mousePressed(MapMouseEvent) method.

Coordinate start;
public void mousePressed (MapMouseEvent e) {
start=getContext () .pixelToWorld(e.x, e.y);

}

13.Implement the mouseReleased(MapMouseEvent) method.

public void mouseReleased (MapMouseEvent e) {

Coordinate end=getContext () .pixelToWorld(e.x, e.y);

try {
double distance=CRS.distance(start, end, getContext().getCRS());
displayOnStatusBar (distance) ;

} catch (Exception el) {
displayError () ;

}

14.Implement the displayError () method.

private void displayError () {
final IStatusLineManager statusBar = getContext ().getStatusBar();
if ( statusBar==null )
return; // shouldn't happen if the tool is being used.
getContext () .updateUI (new Runnable() {
public void run() {
statusBar.setErrorMessage ("Unable to calculate the
distance") ;
}
IO
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15.Implement the displayOnStatusBar(double) method.

private void displayOnStatusBar (double distance) {
final IStatusLineManager statusBar = getContext ().getStatusBar();
if( statusBar==null )
return; // shouldn't happen if the tool is being used.
int totalmeters=(int)distance;
final int km=totalmeters/1000;
final int meters=totalmeters- (km*1000) ;
float cm = (float) (distance-totalmeters)*10000;
cm = Math.round(cm) ;
final float finalcm=cm/100;
getContext () .updateUI (new Runnable () {
public void run() {
statusBar.setMessage ("Distance = "+km+","+meters+"m
"+finalcm+"cm") ;

}

)i

The completed plugin code is in the
tutorials\day\DistanceTool\sources\completeplugin.zip archive file.

7 TESTING THE PLUGIN

1. At this point you may have red x's on the project. Press Ctrl+Shift+0 to
import any needed classes and save the file (this should refresh the project
and clear up any error markers left behind).

2. From the Project menu select Run and choose the configuration you set-up
in the previous chapter (see Section 5 Compiling the uDig Plug-ins).

3. When uDig launches make a new map (File->New Map) and your Distance
tool should now be in the tool bar ready for use. Import a map into the
Catalog (you can drag the DM Solutions WMS map from
http:/ /udig.refractions.net/confluence/display/UDIG /Walkthrough+1 into
the Layers View).

4. Make select the Distance Tool and drag from one point to another in the
Map View and the distance should display in the bottom left corner.

] R

Figure 15 - Distance Tool
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